


















































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































CHAPTER 21: ORGANIZING HYPERTEXT INFORMATION WITH HYPERCARD 559 

Of course a writer is aware of the limitations that must be considered when 
referencing material that is related but not central to the main writing topic. As a 
consequence, the writer is constantly making decisions about which related 
material or references should be included. The result is that the reader is often 
given a very selected set of reference material that can be quite a bit smaller than 
the writer would actually have preferred but that was restricted to keep the main 
writing theme uncluttered. 

READER PARTICIPATION. Unfortunately, the reader has no participation in decid­
ing which reference material is included or excluded; the writer must make these 
decisions for all readers. Although some readers may be intensely interested in a 
subject's historical background, the writer must remember that not every reader 
will have such a perspective. Hence, some compromise position must be taken 
relative to historical background references. In a similar way, the writer must 
restrict reference material in other possible directions. 

If a separate edition could be produced for each reader and that reader could 
participate in the production of that edition, then the reference material would be 
ideally suited for that reader's interests. Of course, if these interests change at a later 
date, then another, different tailored edition would have to be produced. As ideal 
as this sounds, it appears to be absurdly impractical. In fact, it is absolutely 
impractical as long as traditional methods for publishing material are followed. 
However, the concept of hypertext opens doors to exactly the kind of tailoring of 
material to a reader's needs that we have described. 

Using hypertext ideas, many different references can be included in an 
electronic document without disturbing the linear flow of the main document 
theme. The reader can choose to explore any number of these references or none 
at all. The key to these capabilities is that links to these references are embedded in 
the document in very nonintrusive ways. If a reader wishes to ignore them, they 
do not interfere with the reading of the main text. Because a hypertext document 
is presented in electronic form, it is very easy to include multimedia document 
components, such as digitized pictures or sound, as part of the document itself or 
as reference material. Furthermore, the order in which this material is accessed is 
primarily determined by the reader and not by its writer or creator. Using a well­
designed and implemented hypertext document is like having an entire library 
and resource center at your fingertips-with exploration of related topics in 
various directions and media available ahnost instantaneously! 

IMPLEMENTING HYPERTEXT. How is hypertext accomplished? The fundamental 
concept of hypertext is the inclusion within a document of electronic links to 
related information that can be accessed or called directly from within that 
document. These links can be thought of as extended electronic footnotes that can 
be accessed and displayed or not as the reader desires. They are accessed in an 
active mode rather than a passive mode. That is, they must be called into the 
document by the reader, otherwise they are not seen and do not interfere with the 
main document's presentation. 

The links can be represented within the document in many different ways. For 
example, key words might be in bold or highlighted in some different way to 
indicate that they have related material linked to them. By moving a mouse pointer . 
over those words and clicking, or otherwise indicating an interest by means of 

_j 
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special keys (most hypertext systems use the mouse in integral ways), the reader 
can cause the linked information to be retrieved and automatically displayed. 
Return to the original document, or even the previous most recent reference 
material, is accomplished by clicking a Return button or some similar activity. 

Thereareotherways that material might be linked. For example, menus might 
be displayed at the bottom of the screen indicating when additional material is 
available. Or buttons might be provided on the screen so that when they are 
clicked, certain additional material or options are presented. In fact, there are many 
ways to implement the links physically, but however they are implemented, they 
should be easily accessible and nonintrusive. You will see later in this chapter that 
HyperCard allows considerable flexibility in constructing links for moving among 
the information stored in one of its linked documents. 

A BRIEF HISTORY OF HYPERTEXT. The first published description of the concepts 
underlying a hypertext system is generally credited to Vannevar Bush in 1945. 
Bush, who was President Franklin Roosevelt's science advisor, wrote an article to 
encourage a major post- World Warn effort to mechanize and automate a system 
for tracking and using scientific literature. His vision was a machine called a 
memex that would contain a large library of articles, sketches, and photographs. 
The memex would have used microfilm and several viewing screens. The links 
would have been implemented byway ofphoto-cell-readabledotcodes. Of course, 
in 1945 the digital computer was still in its early infancy, so Bush can be excused 
for not anticipating the power his memex and a computer might realize together. 

Actually, this combination was not explored seriously until nearly 20 years 
later. In the 1960s two men, Douglas Engelhart, at Stanford Research Institute, and 
Ted Nelson, at Brown University, set out independently to implement hypertext 
systems. Engelhart's system made use of his own new invention-the mouse. 
Nelson actually coined the term hypertext. Since these beginnings, hypertext 
research has proceeded in many directions. Andrew van Dam and others at Brown 
have created a highly acclaimed and successful system that allows professors to 
author course notes in multimedia hypertext. This project, called lntermedia, not 
only allows professors to create their own hypertext lessons, but also allows 
students to add to the system their own annotations and reports. Rooms are 
available where students can go and explore multimedia information presenta­
tions. To experience the same degree of information exploration using traditional 
methods would require impossible amounts of time and energy on the part of the 
information seeker! 

As you can see from the preceding outline, the ideas inherent in hypertext are 
not really new. Full hypertext systems have been under development for several 
decades. Why, then, do we claim that hypertext supplies you with a new capability 
for information storage and display? The reason is that until quite recently, there 
were no hypertext systems available on relatively inexpensive and widely avail­
able personal computers. The major advances in computer hardware capabilities 
over the past few years have opened up new possibilities for making hypertext 
widely accessible. While the ideas in HyperCard have been around for quite some 
time, the fact that HyperCard is implemented on the Macintosh and is thus 
available to a very large audience enhances the use of hypertext immensely. 
Recently, hypertext systems have become available for the IBM personal computer 
and its compatibles as well. You will be hearing much about hypertext in the future, 



CHAPTER 21: ORGANIZING HYPERTEXT INFORMATION WITH HYPERCARD 561 

because such packages will greatly increase the general awareness of the innova­
tive nature of hypertext as an information presentation tool. 

Exercise Set 21.1 

1. Describe in your own words the idea of hypertext. 

2. Do you think a hypertext document could be implemented without using 
computers? Explain. 

3. What is meant when it is said that hypertext provides for a nonlinear (or 
nonsequential) document construction? Why is this capability important? Can 
you think of any disadvantages it might have for a user? 

4. What traditional writing conventions are used to attempt to achieve some of 
the same goals as hypertext has? 

5. In what ways does hypertext allow the reader to participate in the "construc­
tion" of the document to be read? 

6. · Give your reaction to the statement that hypertext is an exciting new concept. 

7. What is the importance of HyperCard in the history of hypertext? Was it the 
first hypertext system? 

21.2 USING HYPERCARD STACKS 

Figure 21.1 The HyperCard 
icon. 

In this section you will explore the use of the Macintosh hypertext software 
package HyperCard. By working with HyperCard, you will gain additional 
insight into the meaning and importance of the ideas discussed in the previous 
section. Our purpose here is not to learn to build a HyperCard application, but to 
see how to use an existing HyperCard application. In the next section, you will 
learn how to build an application of your own. 

STARTING HYPERCARD. To open HyperCard, find and double-click on the Hyper­
Card icon shown in Figure 21.1. 

When you open HyperCard you will see displayed a screen that is called the 
Home Card. A typical Home Card is shown in Figure 21.2. HyperCard documents 
are called stacks. These documents can be thought of as collections or stacks of 
cards, where each card is the size of a single Macintosh screen. Any information 
that can be displayed on, or accessed from (such as sound and music), a Macintosh 
screen can be placed on a card. 

HyperCard cannot run without a Home Card, and that Home Card is unique, 
because there can be only one Home Card for a particular running copy of the 
HyperCard software. However, the software user can configure the Home Card in 

~ 
HyperCard 

J 
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Figure 21.2 An xample 
HyperCard H me Card. 
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many different ways, allowing access to only some chosen set of stacks. Hence, the 
Home Card shown in Figure 21.2 is only one of many different forms a particular 
Home Card could take. 

The HyperCard Home Card provides access to a number of different card 
stacks. Notice in Figure ~.2 that the mouse pointer has the shape a pointing finger 
(in the lower right corner of the screen). This icon represents the HyperCard browse 
tool, which is used to select and click on buttons that provide automatic links to 
other cards and stacks. 

Notice the Tools pull-down menu (actually, it is a pull-down palette of tools) 
in the menu bar of the Home Card. By accessing this palette menu, you can access 
various tools with which HyperCard cards can be constructed. The palette contains 
some familiar MacPaint tools and some important new tools; we will investigate 
it thoroughly a little later. It is also the case that as you move the mouse cursor 
around on certain cards, its shape (and hence its function and the tool it represents) 
will change automatically. Shortly, you will see that this context-sensitive tool 
selection technique is used extensively in HyperCard. 

MOVING AROUND IN HYPERCARD STACKS. The icons shown in Figure 21.2 are actually 
buttons that form links to various HyperCard stacks, and clicking one of them will 
cause the first card of the appropriate stack to be automatically displayed. For 
example, if you click on the Intro icon (upper left), the first card of the Intro stack, 
shown in Figure 21.3, will be displayed. 

By placing the browse tool over the What is HyperCard? button and clicking, 
the card in Figure 21.4 will be displayed. This card gives an informative graphical 
representa tion of one of the basic ideas in HyperCard. The arrows represent the 
links tha t allow you to move easily from card to card by clicking buttons. Note that 
the cards being linked need not be in the same stack-or even on the same disk. 



Figure 21.3 The firstcard of 
the Intra HyperCard stack. 

Figure 21.4 Card accessed 
by clicking the What is 
HyperCard? button of the 
card of Figure 21.3. 
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Welcome to 

( What is HyperCard?) 

~ ( Go back ) 

As you will see in the next section, such HyperCard link buttons are easy to create, 
and they can be placed anywhere on a card and have many different appearances. 
In fact, the form of HyperCard buttons can range from predefined radio buttons 
and rounded-comer rectangle buttons with the button name inside to icons that 
you design and construct yourself. About the only limitation on a link button is that 
it can link to only one other card. This is not a serious limitation because you can 
have a great many buttons (and hence access to a great many other cards and 
stacks) on a given card. 

HyperCard Is a personal toolkit 
You can use HyperCard to create your own applications 
for gathering, organizing, presenting, searching, and 
customizing information. 
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Figure 21.5 Ca d accessed 
by clicking th Next Card 
button of the d shown 
in Figure 21.4. 

Take note of the arrow button at the bottom of the card shown in Figure 21.4. 
(The browse tool is partially over it.) This is a standard HyperCard button that 
takes you to the next card in the current stack (to the initial card in the stack, if the 
current card happens to be the last one of the stack). Clicking it now causes the card 
in Figure 21.5 to be displayed for the particular stack being used for this example. 

At the bottom center of the card of Figure 21.5, you will notice two arrow 
buttons. The arrow pointing to the right advances you to the next card in the same 

-stack when it is clicked; the one pointing to the left returns you to the previous card 
in the same stack when it is clicked. 

These same two functions of advancing or retracing cards in the current stack 
can also be accessed by selecting the commands Next and Prev, respectively, from 
the Go pull-down menu. In addition, choosing the Home selection from that menu 
will always return you to the HyperCard Home Card. 

SETTING THE USER LEVEL IN HYPERCARD. Let us choose the Home command under 
the Go menu and return to the Home Card to see how to set the user level. There 
are five categories of HyperCard user capabilities, or user levels. The number of 
HyperCard options and activities that are available to you will depend upon which 
of these levels has been selected. The five user levels follow. Each level provides 
capabilities that include all the capabilities of all the levels that precede it in the list. 

• Browsing 

• Typing 
• Painting 

• Authoring 

• Scripting 

Briefly, the browsing level allows a user to look at cards in a stack and navigate 
freely from card to card using buttons; the typing level adds the capability to enter 

Hypercard gives you freedom to associate 
You don't have to be an application author to love 
HyperCard. You can use it to access information in 
app 1 i cations created by other HyperCard authors, 
adding your own information to what's already there. 

January 4 Appts. • Ken Hutchinson 
342 Connecticut Avenue 

8:00 1:00 Edina, MN 55435 
9:00 2:00 

10:00 3:00 Hutchco Enginttrtng 
11 :00 4:00 (612) 555-3435 
12:00 5:00 9~ 
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Figure 21.6 First card in the 
Address stack accessed 
from the Home Card of 
Figure 21.2. 
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text within certain fields that can be predefined on cards; the painting level adds the 
capability to use MacPaint-like tools to create graphics on cards; the authoring level 
adds the capability to create stacks and cards with fields and buttons of your own; 
the scripting level adds the capability to write commands or programs (scripts) in 
the language HyperTalk. 

The menus displayed and the choices available within those menus will 
depend upon what user level has been set. For the rest of this chapter, we assume 
that the user level is authoring. The user level can be set and changed easily by 
accessing the card at the end of the Home Card stack and selecting the appropriate 
radio button. To access this card, you select the previous card button from the 
Home Card. 

AN EXAMPLE HYPERCARD EXCURSION. Before examining some of the authoring ca­
pabilities in HyperCard, let us make one more stack excursion. From the Home 
Card, clicking on the Address icon (see Figure 21.2) causes the card in Figure 21.6 
to be displayed. Note that this card has the standard next card and previous card 
arrow buttons. It also has another standard button in the lower right comer. This 
button allows you to return to the beginning of the stack of which the current card 
is a member. Note that this is different from returning to the Home Card from 
which you access various stacks. 

You will also notice six icon/buttons on the left of the card of Figure 21.6. 
These icon/buttons were placed there by the card's creator, and they have various 
functions. The house-shaped icon is a button that returns you to the Home Card. 
The next two icons represent buttons that provide links to two kinds of calendar 
stacks. Clicking on the first of these causes a calendar similar to that shown in 
Figure 21 .7 to be displayed, with the current week highlighted (the week of July 11-
17, 1988, in the figure). The fourth icon represents a button linked to a note card 
(things-to-do) stack. 

The last two icons are not buttons that are linked to other cards or stacks; they 
are used to initiate actions to be taken on the current stack. The first of these gives 

This is the first card of the Address stack. 
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Figure 21.7 A rd in one of 
the Calendar s cks ac­
cessed from t card of 
Figure 21.6. 
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you a rapid tour of the current stack by accessing and displaying its cards in rapid 
succession. The final icon/button allows you to sort the current stack according to 
the name field on each address card. The icons used are the ones commonly used 
for these actions within HyperCard stacks. 

The particular Calendar stacks in this example are also linked together. If you 
use the browse tool to select a given week as shown in Figure 21.7, an appointment 
calendar for that week will be displayed as shown in Figure 21.8. If you move the 
browse tool to one of the text areas (or fields as they are called in HyperCard), it will 
change to the text tool and you can click and then enter appointments or notes. 
Notice that several such entries have been made in the calendar shown in Figure 
21.8. 

By clicking on the icon shaped like an address card at the top middle of the 
appointment calendar card, you can return to the Address stack. Then clicking the 
next card arrow button will cause a card like the one shown in Figure 21.9 to be 
displayed. Notice the similarities between the cards in Figures 21.2 and 21.9. The 
common features of the cards in a stack are usually stored as a part of a card's 
background. Each card has two display areas called the background and foreground 
areas. These two areas are defined and manipulated independently, but they are 
displayed simultaneously. Although quite frequently it is desirable for all of a 
given stack's cards to have the same background, it is possible for different cards 
within the same stack to have different backgrounds. It is convenient to place 
information that is common to many cards in the background display area and 
then simply to copy the background to all new cards created. We explore this idea 
in more detail in the next section. For example, for the cards in the Address stack, 
it would make sense to place the column of icons/buttons to the left of the 
addresses as well as the arrow buttons at the bottom of the cards in the background 
area, because these features appear on all the cards in the stack. 



Figure 21.8 A card from 
the Appointment Calendilr 
stack accessed from the 
card of Figure 21.7. 

Figure 21.9 A card from the 
Address example stack. 
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STAYING ORIENTED IN HYPERCARD STACKS. One of the potential disadvantages of 
using HyperCard stacks (and other hypertext documents) to access and display in­
formation is the ease with which you can lose track of the information path you 
have followed to get to the card you are presently viewing. For example, you may 
wish to review a card you have previously examined. How will you find it? You 
might be able to use the next card and previous card buttons, but remember that they 
only provide access to the next and previous cards in the current stack. You may 
have accessed the current card from another stack. How do you return to that 
stack? 

I"' 
Katie Aichler 
9424 Middlefield Road 

• 555-4844 
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Figure 21.10 A example 
Recent display creen. 

Figure 21.11 E mple of 
Find comman dialog box. 

HyperCard provides two methods fordoing this kind of backtracking and an 
additional method for finding particular textual information in a stack. Each of 
these stack navigation methods is designed to help you avoid becoming disori­
ented as you move from stack to stack. 

The two backtracking methods are provided through the Back and Recent 
commands in the Go menu. The Back command returns you to the most recently 
visited previous card. By repeatedly using this command, you can retrace your 
entire hypertext session. The Recent command allows you to view the last 42 
different cards you have viewed in compact form. An example is shown in Figure 
21.10 for a HyperCard session (which has not yet visited 42 cards). From this 
display you can go to any card represented by pointing to its representation and 
clicking. The card you were viewing when you selected the Recent command is 
highlighted by an outlined box. Even though the form of the Recent display does 
not allow you to see the details on any of the cards, you can usually pick out the card 
you are looking for by its outlined features. For example, see if you can pick out the 
Home Card, the first card of the Intra stack (shown in detail in Figure 21.3), and the 

This is the first Cllrd of the Address stllck. 
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first Address stack card (shown in detail in Figure 21.6) from the Recent display of 
Figure 21.10. 

A third method for navigating through a HyperCard stack is accessed 
through the Find command in the Go menu. When the Find command is selected, 
a small dialog box is displayed over the bottom of the current card, as shown in 
.Figure 21.11. In this box you type in a text string that you would like to locate within 
the current stack (the quotes are supplied automatically by HyperCard, and the 
cursor is positioned between them for text insertion when the dialog box is 
presented). 

When the Return key is pressed, HyperCard will find and highlight with a 
rectangle the first occurrence of the text string that is found anywhere within a text 
field (you will learn about text fields in the next section) on a card within the current 
stack. By pressing the Return key again, the next occurrence of the string will be 
located. The first occurrence of the string asked for in Figure 21.11 is shown 
highlighted in Figure 21.12. 

Exercise Set 21.2 

1. Describe the organization of HyperCard documents. 

2. How are HyperCard links accessed? Can cards in different stacks be linked? 

3. Describe the methods available in HyperCard to review a card that you have 
previously visited in a session. 

4. What is the function of a Home Card? How many Home Cards can a given 
application of HyperCard use? Is a Home Card required? 

Computer Practice 21.2 

1. Open HyperCard and access the Intro stack. You should have displayed the 
card shown in Figure 21.3. Click the What is HyperCard? button. Access all the 
cards in this stack sequentially by using the next card button. When you reach 
the last card (shown here), select the Home to explore on my own button. 

What next? 
Click Help cards to find out more about exploring 
HyperCard and making stacks of your own. 
Or click Home and rely on serendipity to uncover the 
unexpected. 

• Help cards 

• Home to explore on my own 
~ 
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Figure 21.12 Te t string 
specified in Fi re 21.11 
found and hig ighted 
using the Find ommand. 

lKat i el A i ch 1 er 
~9424 Middlefield Road 

R 555-4844 

2. Next, from the Home Card, access the Address stack. You should have dis­
played the card shown in Figure 21.6. Choose the rapid view icon (next to the 
last icon/ button on the left-hand side of the card). Next choose the Recent 
command from the Go menu. You should get a display like the one shown 
next. Notice that the rapid view cards do not appear on a Recent screen. 

3. From the Recent screen display of step 2, try selecting one of the cards in the 
Intra stack. Next choose the Back command from the Go menu to return to the 
initial card of the Address stack. Follow the link to the Appointment Calendar 
stack (third icon/button from the top on the left side of the card). Move the 
browse tool (pointing finger) over a text area until it is changed into the 1-beam 
text tool. Click the mouse button and then enter some text. Return to the Home 
Card (icon/ button in the upper right comer of the card). 
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21.3 CREATING HYPERCARD STACKS 

Agure 21.13 Background of 
the Home Card displayed. 

In this section we will go through an outline of the steps required for you to create 
your own HyperCard stack. At the end of the section you will be asked to create 
the example stack. The stack we will create will be small and incomplete; we will 
put in only enough cards to illustrate the major ideas. It will be named Literature 
and will contain information about major literary personalities and works. 

To begin, open HyperCard. You should now have the Home Card displayed. 
Before you proceed, it will be instructive for you to see what information is in the 
background area of the Home Card. To do this, select Background from the Edit 
menu. You will then see a screen like the one in Figure 21.13 (provided the original 
HyperCard Home Card has not had its background area modified). Notice that the 
only objects in the Home Card background area are the next card and previous card 
buttons. Also notice that the menu bar has a different lower border; this border 
indicates that you are viewing the background of the card only. To return to a view 
of both background and foreground areas for the card, select Background again 
from the Edit menu. 

With the full Home Card displayed, select New Stack from the File menu. You 
will then be given the dialog box shown in Figure 21.14. Type in the name of the 
stack, Literature. You will notice that you are offered the option of copying the 
current background as the default background for the cards of your new stack. 
Select this option so that each of the cards in your new stack will inherit the next card 
and previous card buttons from the Home Card background. The actions of these 
buttons will be automatically adjusted to reference cards in your new stack. To 
complete the definition of the new stack, click the New button. 

When the definition of the new stack has been completed, the first card (and 
currently the only card) of the new stack will be displayed. It will look like the card 
shown in Figure 21.13 except that the menu bar will not be bordered as it is in that 
figure. Before we place buttons on the present card and create additional cards for 
the stack, we will add some information to the card background. To begin this 
activity, select the Background command from the Edit menu. 

Menu bar border shows that background 
only is being displayed ~ 

• File Edit Go Tools Objects ... .I ~ 

,...¢C)" 
. / ........... 

Prev1ous card button Next card but ton 
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Figure 21.14 Di og box for 
definition of a ew Hyper­
Card stack. 

Figure 21.15 H rCard 
tools palette. 
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The tools available for creating card displays are found under the Tools pull-down 
menu and are shown in Figure 21.15. You will recognize many of the tool icons 
from your work with MacPaint. These HyperCard tools have functions almost 
identical to their MacPaint counterparts. Some of these tools have enhancements 
and additional capabilities in HyperCard, butwewillnotneed thosecapabilitiesfor 
our example and so we will not discuss them here. 

The three tools in the first row of the HyperCard tool palette have functions 
quite different from those of the drawing tools. You have already seen that the 
primary functions of the browse tool are to select and follow button links and to 
access and choose commands from pull-down menus. The button tool is used to 
define and set the characteristics of link buttons. Similarly, the text field tool is used 
to define areas on cards called text fields. As the name suggests, text fields are areas 

Browse 
tool 

Button tool 

IJO'--­
==·m DO 
&oc:? 

o a. _ _. 

MacPaint-11ke tools 



Agure 21.16 New 
background information 
added to the first card of 
the new stack. 
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on a card where text can be entered. You have seen an example of the use of a text 
field in the Appointment Calendar stack of the previous section. In contrast to textual 
information entered using the MacPaint type of text drawing tool, textual informa­
tion in text fields can be edited using common word processing techniques. As in 
MacPaint, text entered with the drawing text tool must be edited as a graphics 
object using the eraser, lasso, and so on. 

With the background area for your first card accessed (as illustrated in Figure 
21.13), you can use the HyperCard drawing tools to create additional background 
display information. Figure 21.16 shows the card after a graphics object and some 
text have been so entered. Once this information has been placed in the background 
area, the Background command should be selected once again from the Edit menu 
to return the display to both background and foreground, as shown in the figure. 
Once this is done, any information entered with the HyperCard tools or by pasting 
from the Clipboard will be entered to the foreground of the card. New cards are 
created by choosing the New Card command from the Edit menu. A new card 
inherits the background information (but not the foreground information) of the 
card that is displayed when it is created. 

Next, we will add a link button to the first card of our new stack. First, we will 
copy a graphics object to serve as the icon for our button from a card of the Art Ideas 
stack provided with HyperCard. (Alternatively, we could create such an icon 
directly on the card using the drawing tools.) To access the Art Ideas stack, choose 
Home from the Go menu, then select the Art Ideas stack icon. 

From the first card of the Art Ideas stack. click on the People, Humans button. 
Near the middle of the card that is subsequently displayed, you will find the 
human bust figure (which we will use to represent the class of English poets) seen 
in Figure 21.17. Select this object with either the marquee or lasso tool and copy it 
to the Clipboard by selecting the Copy Picture command from the Edit menu. 

Select the Back command from the Go menu several times until you are 
returned to the first card of your new stack (or select the Recent command and click 
on the representation of this card). Now select Paste from the Edit menu; the 
graphics object will be placed on your card. It can then be moved to the position 
shown in Figure 21.17. 

We intend for the bust graphic to serve as an icon for a button that will link 
this card to a card representing English poets. To create the button, first select the 
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Figure 21.17 Th first card 
of the new sta with an 
icon pasted an a button 
created. 

Figure 21.18 Th card of 
Figure 21.17 wi h the but­
ton resized an moved to 
cover the bust i on. 
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button tool from the Tools menu. Next choose the New Button command from the 
Objects menu. Your card should now look something like the one pictured in 
Figure 21.17. By moving the pointer to the lower right comer of the button and then 
dragging, you can resize the button rectangle. By moving the pointer inside the 
button area and then dragging, you can move the entire button on the card. Using 
these techniques, it is easy to position the button so that it covers the bust icon as 
illustrated in Figure 21.18. 

To complete the definition of the button, select the button (if it is not already 
selected) by clicking on it. Once the button is selected, choose the Button Info 
command from the Objects menu. The dialog box shown in Figure 21.19 will be 
presented. In this box you can name the button and set some of its properties. The 
settings selected in the figure will make the button transparent (so that its icon can 
be seen through it) and cause the button to be highlighted (by inverting the pixels 
inside it) whenever the pointer is clicked and held inside it. When you have 
finished making the desired settings, click OK. Figure 21.20 illustrates how the 
button should then appear. 

File Edit Go Tools Objects 
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Figure 21.19 Dialog box for 
setting button characteris­
tics. 

Figure 21.20 Positioning the 
new field under the but­
ton. 
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Button Nome: ~~~!!!~~!!!!!!!!!!!!!!!!!!!!~ 
Cord button number: 1 Style: 
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0 radio button 

Cancel ) 

Next we will place a text field under our button to identify its purpose further. To 
do this, you select the field tool from the Tools menu and then select the New Field 
command from the Objects menu. The new field can be sized and moved 
analogous to the way those activities were done for the button earlier. Using these 
techniques, you can position the field as shown in Figure 21.20. 

The characteristics of text fields can be set in a manner similar to that used for 
buttons. To do this the field is selected (first the field tool must be selected if it is not 
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Agure 21.21 Di og box for 
setting field ch racteristics. 

Agure 21.22 Di og box for 
setting a field's font char­
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already active) by clicking within its area and then choosing the Field Info command 
from the Objects menu. When this is done, a dialog box like the one shown in 
Figure 21.21 will be displayed, and the field's characteristics can then be set. 

By clicking the Font button in the Field Info dialog box, you can access the 
dialog box shown in Figure 21.22. Using this dialog box, you can make various 
settings familiar to you from your word processing experience to affect the 
appearance of text entered into a field. Note that these settings are global for the 
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Figure 21.23 The first Litera­
ture stack card after plac­
ing the button and text 
fields on it. 
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field. Hence, you cannot change settings for particular words or characters, only 
for the field as a whole. 

After completing the field characteristic settings, you are returned to the card. 
If you now select the browse tool and move the tool over the new text field area, 
it will change to an 1-beam. After clicking, the pointer will change to a text insertion 
pointer (blinking vertical line) and you can enter text into the field. Because we 
have set the field to be transparent, it may be difficult to place text in multiline fields 
correctly. If this is the case, the field characteristic could be changed to rectangle 
while text is being entered and then reset to transparent later. Figure 21.23 shows 
the card with text entered and the browse tool active. You are now ready to define 
the link that this button will implement. 

To define a link (or later to change the link) for a button, first select the button 
tool from the Tools menu. Next, select the button of interest by clicking anywhere 
within the button area. When the button is selected, an outline of the button area 
will be visible, even though the button itself may have been previously set to 
transparent. Once the button is selected, choose the Button Info command from the 
Objects menu. Once again this will result in a dialog box as shown in Figure 21.19. 
In the box displayed, click the LinkTo button; the dialog box shown in Figure 21.24 
will be presented. 

With the Link Definition dialog box on the screen, you can use any of the Go 
menu commands or other card link buttons to locate the card to which you wish 
to link. While you navigate through various cards and stacks, the dialog box will 
remain on the screen, except when you choose the Recent command from the Go 
menu. In that case, the Recent screen will temporarily cover the dialog box until you 
choose a card from it. Note that you can move the dialog box, by dragging on its 
upper border, to examine a card more completely. . 

You can also d efine a new card to which you wish to link by selecting the New 
Card command from the Edit menu. In fact, that is what we want to do here. Once 
a new card has been created and is displayed, complete the link definition by 
clicking the This Card button. When you do this you will be returned to the card on 
which the button resides. The link has now been implemented. To move to the new 
card to place information on it, you simply select the browse tool and click the 
newly linked button.Figure 21.25 shows the new card with four text fields added 
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Figure 21.24 Di log box for 
defining a butt n link 
destination. 

Figure 21.2 New card 
with text f1elds 
added. 
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Go to destination, then aim linlc at: 

( This Card ) ( This Stacie ) ( Cancel 

to it. Note that the background from the card that was active when the new card 
was created is copied automatically to the new card. 

In Figure 21.26, text has been entered into the text fields by first selecting the 
browse tool and then moving it over the text fields and clicking to access the text 
entry tool. The text fields have also been made transparent, which means that the 
boundaries do not show. The title English Poets was added using the drawing text 
tool. 

Figure 21 .27 shows new buttons placed over the text fields. Note that each 
button has been sized appropriately to cover its associated text field. The buttons 
next should be selected in turn and their characteristics (transparent and auto hilite) 
set in dialog boxes obtained using the Button Info command in the Objects menu 
(see Figure 21.19). 

Using the techniques described earlier, you can create new cards to which 
each of these buttons will be linked. We will illustrate briefly for the 18th Century 
button. Suppose we decide to put a card for the poet William Blake as the first card 
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Figure 21.26 The new card 
with text fields entered 
and a title added to the 
foreground. 

Figure 21.27 Placing but­
tons over the text fields. 
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18th Century 

19th Century 

20th Century 

English Poets 

in the group of cards for this category. Figure 21.28 shows a possible configuration 
of fields for such a card. 

The larger field shown on the card in Figure 21.28 is to be set to be a scrolling 
field (see Figure 21 .21). Additionally, two buttons, Major Poems and Con temporaries, 
are be added to the card as illustrated in Figure 21.29. Note that these buttons have 
been named and the buttons and names are displayed instead of button icons. To 
accomplish this, the buttons are set to Round rect, and the Show name feature is 
selected (see Figure 21.19). Using these buttons, a Literature stack user could view 
more information about William Blake. 

We would place information in the stack about another eighteenth-century 
poet by linking the next card button to a new card and then placing that information 
on the new card. Continuing this process, we would define a sequence of cards 
containing introductory information about all the eighteenth-century poets to be 
placed in the stack. 

Figure 21.30 shows the first card to be linked to the Major Poems button. Note 
the use of the scrolling field and the digitized image that has been pasted on the 
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card. (This image was copied to the Clipboard from the Slide Show stack included 
as a demonstration stack with HyperCard and then pasted onto the card shown.) 

With the use of a scanner device, images can be digitized and copied into 
drawing/paint programs. These images can then be modified if desired and 
copied to other documents, such as HyperCard stacks. It is also possible to call 
other applications directly using HyperCard links. Hence, programs like 

Literature Stack 

William Blake 

Blake ( 1757-1 827) is known as a poet, $!, 
an artist and a philosopher. As a poet, 

~·r~t~0;sds ~~s ~:~:;;"~;~~~~~~~~~~~to ~ 
two main categories-- lyrical and 0 

(Major Poems) (Contemporaries) 



Figure 21.30 An additional 
Literature card using a 
digitized image. 

CHAPTER 21: ORGANIZING HYPERTEXT INFORMATION WITH HYPERCARD 581 

The T1ger 

Tiger I Tiger I burni 119 bright, 
In the forest of the night, 
What immortal hand or eye 
Could frame thy fearful symmetry? 

In what distant deeps or slcles 
Burnt the fire of thine eyes? 
On what wings dare he aspire? 
What the hand dare seize the fire? 

And what shoulder, and what art, 
Could twist the sinews of thy heart? 
And when thy heart began to beat, 

ConcertWare+MIDI and MacRecorder could be called to include audio compo­
nents within a HyperCard stack. Programs like Video Works II could provide 
easily constructed animation. There are many exciting possibilities for innovative 
multimedia information presentation using HyperCard. Although some of these 
ideas are beyond the scope of the introductory overview in this chapter, with what 
you have learned here and in Chapter 20, you have all the necessary tools to begin 
an exploration of these ideas on your own! 

Computer Practice 21.3 

1. Construct your own version of the Literature stack described in this section. 
Include all the components whose construction is outlined here. 

2. Add several more eighteenth-century poets to the Literature stack you con­
structed in step 1. Include cards for several major poems for each of them. 

3. Add several nineteenth-century poets and some of their major poems to the 
Literature stack of step 2. Create some Contemporaries button links among these 
poets. 

4. If you have access to a scanner device, digitize some appropriate images and 
place them on cards in your Literature stack. 

Key Concepts 
Background card area 
Electronic links 
HyperCard cards 
Hypertext 
Multimedia stacks 
Stack navigation methods 

Defining links 
Foreground card area 
HyperCard stacks 
Icon/button 
Nonlinear documents 
Text fields 
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493 
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data object operators and built-in func-
tions,500-504 

menus, 490-491 
overview, 489-491 
sheet-level editing, 495-500 

commands: 
Copy, 496 
Cut, 497 
Delete, 495 
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selecting: 

document, 357 
line, 357 
paragraph, 357 

selection bar, 357 
special symbols, 364 
spelling checking, 366-368 
split windows, 371 
starting, 356-357 
styles, 357-358, 381-382 
tabs, 361 
user dictionaries, 366 
vertical line icon, 362 
Word window, 357-358 

Microsoft Works, 19, 127, 129, 132-136, 
139-153 

closing·a document, 142 
communications module, see Works commu­

nications module 
creating a new document, 139-140 
data base module, see Works DB 



deleting a document, 149 
headers and footers, 146, 148-149 
Help feature, 143-145 
opening, 139 

existing document, 140-141 
printing a document, 145-147 
resuming, 150-151 
saving a document, 141-143 
spreadsheet module, see Works 55 
summary of commands, 151-153 
word processing module, see Works WP 

MIDI, 538 
keyboard, 34 

MIDI-compatible synthesizer, 35 
MiniFinder, 88 
Modem connector, 37 
Modem, ~. 35, 131, 310, 313 

smart, 313, 314, 322 
Modulation, 310 
Mouse, 9, 33, 39, 56, 560 

click button, 10 
operations: 

clicking, 39 
double clicking, 10, 39 
dragging, 39 
pointing, 39 
pressing, 39 
shift clicking, 39 

pointer, 9 
M5 Word, see Microsoft Word 
M5 Works, see Microsoft Works 
MS-D05 operating system, 95 
MultiFinder, 88-89 
multi-media stacks, 581 
Multiplan, 238 
Multiple-valued link attributes, 446 
Music synthesizer, 22 

N-tuple, 511 
NASA, 25 
Nelson, Ted, 560 
Network, 37, 61-63, 65-67, 113 

device allocation, 61 
selecting a printer, 64-66 

Nonlinear document, 558 
Nyquist frequency, 533 

Object: 
name of open, 48 
opening, 10, 44-46 

Operating system, 32 
Operating the Macintosh, 38-50 
Operators: 

Cartesian product, 428 
cross, 428, 429, 430 
logical, 452 
minus, 428, 429 
natural join, 428, 430, 433, 436, 440, 447, 

452, 469 

project, 428, 487, 511 
select, 428, 430, 487, 511 
union, 428-429 

Option key, 72-73 
Output devices, 34-35 
Overlaying dip animations, 550 
PageMaker: 
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changing text appearance, 406 
character and paragraph specifications, 

411-413 
commands: 

Actual Size, 408 
Autoflow, 403 
Column Guides, 400-401, 415 
Guidance, 408 
P~, 416, 42Q-421 
Rulers, 396, 415 
Wrap Text, 420 

cropping tool, 398-399 
drawing board, 395, 396 
facing pages, 399-400 
features, 396-413 
flowing text, 403, 417-420 
greeking, 412 
kerning, 413 
leading, 417 
manual placement, 417 
master page icons, 398 
menus, 424 
multiple columns, 40Q-401 
page design, 414-420 
page size, 404-405 
pasteboard, 395, 396 
placing graphics, 408-410 
placing text, 402 
regular page icons, 397 
ruler guides, 402 
ruler zero point, 396 
snap to guides, 406 
special text placement, 406-408 
starting, 396 
text placement modes, 402-403 
text wrap, 420 
threading text, 405 
toolbox, 398 
using, 414-424 

automatic methods, 42D-421 
manual methods, 414-420 
text wrap feature, 41Q-411 

windowshades, 405 
Paragraph, see Word processing 
Paragraph indents, see Word processing 
Parentheses, 264 
Parity, 318 
Path name, 102 
Peripherals, 114 
Pitch, 533 
Pixar, 26 
Pixels, 34-35, 544 
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Pointer attributes, 446 
Pointing, see Mouse 
Port: 

printer, 37 
SCSI, 38 

Precedence of operators, 214 
Pressing, see Mouse 
Printer: 

dot matrix, 62 
drivers, 113-114 
laser, 62 

Program, 59 
Protocol, 131, 311 
Public domain software, 309 
Pull-down menus, 15-17 

RAM, 31, 156 
Random access memory, see RAM 
Range, 483 

notation, 483 
of a function, 259 

Read only memory, see ROM 
Real-time computing, 535 
Record, 511 
Records, 130, 186 
Reflex Plus, 20, 131, 185, 187, 188, 210 

changing selection criteria, 467-468 
commands: 

Blank Record, 458 
Clllculate, 467 
Enter Record, 458 
First Record, 458-459, 462 
Label, 472 
Next Record, 458-459, 462 
Repeating Collection, 471 
Report, 466 
Revert to Old Report, 47D-471 
Save Report, 471 
Sort On Fields, 467 

configuring the database design, 454 
constructing reports, 463-468 
creating: 

databaSes, 452-457 
reports, 464 

adding descriptive labels, 472 
Datllbase Overview Window, 453, 457-458, 

476-477 
data entry, 457-461 

modifying entry forms, 458 
related records and link attributes, 

459-460 
using a default form, 457-458 

data retrieval, 461-463 
adding a new relation, 476-477 
multiple relations, examples, 468-477 

displaying a report, 466-467 
editing records, 459 
entering: 

link information, 454-456 

relation definitions, 453-454 
formula box, 469-470 
~ attributes, 464 
modifying a report layout, 465 
quitting and restarting, 456 
repeating collections, 465-466 

nesting, 468 
Return key, 460 
select operator retrievals, 461-463, 464 
Tab key, 460 
viewing the contents of a relation, 458-459 

Relation, 188, 191 
Relational algebra, 210, 428-431 

arithmetic operators, 214-216 
basic operators, 210 
comparison operators, 216-217 
derived operators, 210 
left-to-right rule, 215 
logical operators, 217-21 
operators: 

Cartesian product, 428 
cross, 429 
minus, 429 
natural join, 430, 433, 436, 440, 447 
project, 211-212, 213, 227, 229, 428 
select, 210, 211, 213, 214, 219, 428, 430 
union, 428-429 

Relational: 
retnevallanguage, 210 

relationally complete, 210 
schemes, 192 

equivalent, 192-193 
Relational database, 19o-193, 428-450 

data types, 193 
implementation, 439-444 
implementing different types of relation-

ships, 444-448 
implementing relationships, 439-444 
indexes (indices), 444 
key attributes, 444-446 
link attributes, 446-447 
management system, 186 
misuse of word, 440 
model, 131 
multiple-valued link attributes, 446-447 
pointer attributes, 446 
relationships, modeling, 441-443 
relationships between relations, 433, 440-441 
retrievals, inefficiency, 443-444 
retrievals using relational algebra, 432-439 
storage requirements, 448-450 
variable length attributes, 446 

Relative reference, 266, 267 
Repeating collections, 465-466 
Resource management tools, 88-90 
Resources: 

CPU, 88 
disk, 87 
human-computer interface, 88 



input/output, 88 
printing, 113-115 

defining the page setup, 114-115 
ROM, 32,41 
Ruler, Works WP, 163 

Sampling rate, 531-533 
Scanner, 34, 395 
Scrapbook, 88, 116-119 
Screen, 34-35 

bit mapped graphics, 35 
Scroll: 

arrows, 48 
bars, 48 
boxes, 48 

Scully, John, 4 
Semantics, 58, 59 
Set, 188 
Shift clicking, 39, 167 
Simple object, 482 
Size box, 49 
SoundEdit, 535 
Spooling, 159-160 

printer, 62 
Spreadsheets, 128-129, 236-243, 259-265, 

282-287 
absolute reference, 266 
active cell, 242 
built-in functions, 282-287 

conditional, 284-286 
example, 283-284 
invoking, 283 
non-numeric, 284-286 

cell, 238-239 
cell-level editing, 241, 242-243 

operators, on data objects, 260-264 
contents of cells, 239 
data object, 239 

entry, 242-243 
operations, 241 

data type, 239-240 
explicit data type, 240 
formatting data objects, 240 
formula, 128 

bar, 243 
object entry, 243 
objects, 240, 242 
~ces, 261-262 
template, 268 

implicit data type, 240 
introduction, 236-238 
logical operators, 265-266 
operations on objects, 242 
operator precedence, 263-264 
overview, 238-240 
parameter, 236 
power, 286-287 
problem-solving strategy, 260-261 
sheet-level editing, 266-271 
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combining absolute and relative reference, 
271 

inserting rows or columns, 269-270, 272 
replicating fonnulas using absolute and 

relative addressing, 268-269 
sheet-level operations, 241, 242 

SQL, 210 
Stacks, 561 
Stanford Research Institute, 560 
Structured object, 482 
Style, see MS Word styles 
Subset, ·188 
Syntax, 58, 237 
System folder, 40 

Table input cell, 507 
Tables, 483-488 
Text insertion pointer, 100 
The Source, 309 
TheaterGame, 22 
T~mbre, 542 
T~me-sharing, 7 
ntle bar, 48 
Top-clown problem solving, 78 
Transducers, 529 
Trash can, 9 
Truth table, 217 
Tuple, 188, 191 

UNIX,95 
Utility folder, 120 

Van Dam, Andrew, 560 
Variable length attributes, 446 
Vectors, 482 

input, 486 
Vibrato, 543-544 
VideoWorks animation subsystem: 

animation using easels and channels, 
553-554 

animation, 551 
Cast, 553 
channels, 551-552 
consbucting Easels, 554-555 
Easels, 553 
&ame-by-&ame animation, 554 
&ames, 551 
Real-T1me Recording, 553 
Score, 551-552 

VideoWorks ll, 547-555, 581 
Overview subsystem, 547-548 

constructing a time line, 548-551 
MacPaint File icons, 547-548 
maao functions, 550 
Panel, 548 
Playback Head, 548 
Stage, 548 
time line, 547 
T~mer, 547-548 
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Vll'tual computer worlds, 528-529 
VisiCalc, 236 
Visual computer output, 6-7 
Visualization of computer output, 18-26 
Visually oriented computing, 4-6 

importance of, 26-27 
uses of, 24-26 

Volts, 530 

Weinberg, Richard, 4 
What if analysis, 128, 236 
Wmdow,9 

active, 10, 46, 48 
enlarging, 49 
features, 46-49 
menu, 136, 140 
moving, 49 

Wmdowing environments, 5-6, 7, 8 
Word, see Microsoft Word 
Word processing, 155 

character formatting, 158-159 
concepts, 156-160 
creating a document, 156 
editing a document, 158 
entering text, 157-158 
formatting a document, 158-159 
invisible character, 157 
paragraph, 157 

formatting, 159 
indents, 160 

printing, 159-160 
section formatting, 159 
wordwrap, 157 

Word p~ssors, 126-127 
Works communications module, 311, 314-315 

adding or changing telephone numbers, 
323 

answering the phone automatically, 323 
baud rate, 317 
capture text, 319, 320-321 
commands: 

Capture Text, 319, 32Q-321 
Dial, 322-323 
Hang Up, 329 
Receive File, 327 
Send File, 326-327 
Send Text, 325-326 
Settings, 317 

connect to, 318-319 
creating a document, 314-315 
data size, 317 
dialog box, 317-319 
ending a session, 329-330 
handshake, 318 
line delay or character delay, 318 
making a connection, 320-323 
number of screens, 319 
parity, 318 
saving a document, 315 

sending: 
and receiving information, 325-327 
sending using the keyboard, 325 
text, 325-326 

stop bits, 318, 328 
terminal type, 319 

Works DB, 187, 188, 210 
adding a calculated field, 341-343 
commands: 

Add New Field, 231 
Change Report Title, 230 
Cletlr, 200 
Copy Totals, 231, 232 
Cut, 200 
Delete Field, 227 
New Report, 229, 231 
No Grid, 197 
Page Setup, 229 
Prepare to Merge, 202 
Print Merge, 204 
Record Selection, 222 
Set Field Attributes, 194 
Show Clipboard, 232 
Show Field Data, 203 
Show Field Names, 203 
Show Form, 197 
Show List, 197 
Sort, 197 
Total on Field Change, 232 

correcting mistakes in data, 195-196 
creating: 

database table, 193-201 
reports, 228-232 

defining database tables, 194-195 
deleting records, 200 
entering data, 195-196 
merging databases and word p~ssing doc-

uments, 202-204 
multiple condition record selections, 223-227 
sample database, 221-228 
saving: 

database, 200-201 
subsets, 227-228 

selecting: 
and displaying information, 221-228 
records, 222-223 

sorting records, 197-198 
totals and subtotals, 231-232 
viewing data: 

in a form display, 196 
in a list format, 197 
using split screens, 198-200 

Works information management problem, anal­
ysis of data, 344-346 

Works SS, 237, 243, 263, 264, 283 
absolute reference, 272 
active cell, 246 

location descriptor, 273 
bar chart, 251 



beginning a session, 244-246 
built-in functions, 287-293 

financial, 288-289 
logical, 288 
mathematical, 287-288 
statistical,· 289-290 
trigonometric, 288 
using, 290-293 

cell labels, 251 
editing, 244-249 

cell-selection pointer, 248 
functions, 247-248 

charting and graphing features, 251-256 
commandi 244-245 

Clear, 275-276 
Copy, 272-273 
Cut, 272, 273 
Draw Chart, 256 
Erase Chart, 256 
Fill Down, 273-275, 298 
Fill Right, 273-275, 303 
Go To Cell, 246 
Insert, 272 
Muve, 273 
New 5erits Chart, 346 
Paste Function, 287, 290, 292-293 
Paste, 272-273 
Paste with Options, 273 
Set Field Attributes, 341 
Show Active Cell, 246 
Sort, 276-277 

data entry termination, 246-247 
editing data objects and formula objects, 247 
example data object entry, 248 
formatting cells, 301-302 
formula bar, 247 
1-beam pointer, 247 
insertion pointer, 247 
line chart, 251 
operators, 265-266 

comparison, 265 
logical, 265-266 

pie chart, 255 
range selection, 248-249 

example of data entry, 249 
shift-dick, 249 

relative reference, 272 
replicating a formula, example, 297-301 
sample problem, 295-303 
selection of active cell location, 246 
setting column width, 277-278 
sheet-level editing, commands, 271-278 
sort operation, 301 
summing values, 302-303 

Works WP, 156, 162, 356 
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changing the size of a figure, 177 
character formatting, 175 
commands: 

Copy Format, 175 
Draw, 176 
Find, 179-180 
Go to Page#, 181 
Hide Ruler, 163 
Page Break, 176 
Page Setup, 160, 170 
Replace, 180-181 
Select All, 167 
Select Picture, 177 
Spacing, 173 
Undo, 167 

copying: 
paragraph formats, 175 
text, 169 · 

deleting: 
pictures, 168 
text, 167-168 

document font, 171 
drawing, 176-177 
editing: 

figure, 177 
text, 164-169 

entering text, 162-164 
formatting, 17Q-177 
indenting, 171-172 

hanging, 171 
inserting: 

pictorial data, 165 
text, 165 

justification of text, 173-174 
line spacing, 173 
moving: 

figure, 177 
text, 168 

page: 
breaks, 176 
formatting, 17Q-171 

paragraph formatting and rulers, 171-173 
searching text for character strings, 179-181 
selecting text, 165-167 
tabs, 172-173 

Works, see Microsoft Works 
Worksheet, 238 
WYSIWYG, 19,395 

Xmodem: 
data, 311, 326 
protocol, 326 
text, 311, 326 

Zoom box, 48 
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t:XPWRING MACINTOSH 
BY ABfRNfTHt NANNfY AND PORTfR 

At last. an introduction to the powerful world of personal computing 
from a Macintosh perspective. This is the only book to explore such 
popular Macintosh applications as Word Processing, Spreadsheets, 
Database Management, Graphics, Desktop Publishing and more. 
Exploring Macintosh contains exercises using today's most popular 
packages, including: 
o MacPaint® o Microsoft Word~ Works® and Excel® o Reflex Plus® 
o Aldus Pagemaker® o HyperCard® 
Beginning users will welcome this hands-on approach to learning 
the Macintosh. 




